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Introduction

1. Introduction to SAP Crystal Dashboard Design
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Just like a pilot gets lots of information in one glance of the airplane’s dashboard, managers can get lots of
information in one glance of a well-designed dashboard.

SAP Crystal Dashboard Design is a data dashboard design tool that displays summary-level business data
in a visually rich and intuitive format that allows users to analyze and interact with their data in order to make
better business decisions.

SAP Crystal Dashboard Design has the ability to show data using gauges, charts, and other components, to
generate interactive flash files, and to generate “what if’ scenarios — all of which are tremendous tools for
decision-making.
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2. SAP Business One and the Integration Component

Since SAP Business One PL12, the integration component for SAP Business One 8.8 comprises a number
of business scenarios that enable you to integrate the SAP Business One application with third-party
software and mobile devices. The predefined SAP Crystal Dashboard Design package in B1iC integrates
SAP Crystal Dashboard Design and SAP Business One, accessing to the SAP Business One Company
Databases with via HTTP(S) request and displaying dashboards with Adobe Flash Player in SAP Business
One Application. Three predefined Dashboard Packages about Financial, Sales and Services are available
by default from SAP, SAP also enables partners or Business Partners to develop their own Dashboard
Packages and deploy them in SAP Business One. The following diagram shows the components of
Dashboards in run-time.
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B1iC
Services

Http(s)

A
=
o
3
()
=
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® SAP Business One Integration Component (B1iC)

There are three predefined service packages available in the integration component: SAP Crystal
Dashboard Design, Mobile and Datev HR. The predefined SAP Crystal Dashboard Design service
package in B1iC provides the connection to SAP Business One Company Database in run-time.

® SAP Business One Application

In order to use the dashboard feature, you should have SAP Business One 8.8 PL12 or higher version
installed. Also you need to enable the Cockpit/Dashboard features from General Setting of SAP
Business One. Adobe Flash Player 9.0 or higher version is required to view the dashboards.

3. SAP Business One Dashboard Packaging Wizard

This tool may be necessary when you want to create new dashboard packages. It can help to automate the
dashboard packaging after designing the dashboards with SAP Crystal Dashboard Design. It is a free-of-
charge SAP Business One Add-On developed by SAP Business One Solution Architect team.

You can download the tool here: http://www.sdn.sap.com/irj/sdn/businessone?rid=/library/uuid/601ca48d-
67a8-2d10-ebb1-8d1b968059b2
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4. SAP Crystal Dashboard Design

In order to create your own dashboards, you need to have SAP Crystal Dashboard Design 2008 Fix Pack 3.1
or higher installed. (Formerly as Xcelsius)

About Xcelsius x|
J Keelsius Enterprise 5.3.1.0
Vet
Build Mumber 12,3,1,776

hittp: A Ay, zap. comyezolubionz /zapbuzineszobjects

4.1 How to Obtain SAP Crystal Dashboard Design

= You need to buy SAP Crystal Dashboard Design separately.

For information on buying SAP Crystal Dashboard Design, contact your local SAP representative.

= |n this demo, we use the SAP Crystal Dashboard Design Department Edition license.

For more information about SAP Crystal Dashboard Design, please refer to the Business Object tools
landing page:

https://websmpl06.sap-
ag.de/~form/sapnet? SCENARIO=01100035870000000183& SHORTKEY=01100035870000711038& OB
JECT=011000358700000566202008E& ADDINC=011000358700001192682007E&

4.2 SAP Business One Data and SAP Crystal Dashboard Design

SAP Crystal Dashboard Design can work with data from different sources. In the following sample, we will
show how to display live data from SAP Business One in an SAP Crystal Dashboard Design dashboard with
XML Data Connection.
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5. Software Prerequisites
5.1 Run-Time Phase
Software List

SAP Business One 8.8 PL 12 or higher

H More Information

Enable Cockpit and Dashboard properly.
Refer to Working with Dashboard Documentation about
the default dashboards.

Integration Component

Refer to the Administrator Guide of integration
component for more information

Adobe Flash Player 9.0 or higher

You can download it from: www.adobe.com

5.2 Design-Time Phase

For the partners, to create new dashboards, you must ensure that the following software has been installed

with the appropriate configuration and settings.

Apart from the software required in run-time, you need the following additional software to create new

dashboard for design-time.
Software List

SAP Crystal Dashboard Design 2008 Fix
Pack 3.1 or higher

‘ More Information

SAP Crystal Dashboard Design 2008, Departmental
edition or personal edition, including Data Manager.

Departmental Edition:

Unlimited data connections to the underlying data source
http://www.sap.com/solutions/sap-crystal-
solutions/dashboards-visualization/sapcrystaldashboard-
starter/index.epx

Personal Edition: (formerly Xcelsius Engage software)
http://www.sap.com/solutions/sap-crystal-
solutions/dashboards-visualization/sapcrystaldashboard-
personal/index.epx

n Recommendation

You are recommended to install the departmental edition.

Microsoft Excel 2003 or 2007

It is used by SAP Crystal Dashboard Design.

SAP Business One Dashboard
Packaging Wizard

Optional but strongly recommended. You can download it
for free from here:
http://www.sdn.sap.com/irj/sdn/businessone?rid=/library/u
uid/601ca48d-67a8-2d10-ebb1-8d1b968059b2
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5.3 Licensing
SAP Business One standard dashboards

Users of SAP Business One are fully licensed to view the SAP developed standard dashboards. These
licenses are included in all user licenses for SAP Business One.

However users can not use these licensed to develop or view customized dashboards.

Developing customized dashboards:

For developing dashboards you will need to purchase a valid license for SAP Crystal Dashboard Design
which includes “live data connections to external data sources”.

For more information see: http://www.sap.com/solutions/sap-crystal-solutions/dashboards-
visualization/productcomparison/index.epx

Using customized dashboards

Dashboards which are not developed and provided by SAP are not covered under the standard licenses.
Additional named-user licenses have to be obtained with the “viewing option” to use the customized
dashboards.

For more information see: http://www.sap.com/solutions/sap-crystal-solutions/dashboards-
visualization/productcomparison/index.epx

Creating Dashboard Packages for SAP Business One 8.8

In the following demo, we’ll generate an SAP Crystal Dashboard Design dashboard showing the Top 10
Business Partners in SAP Business One, using the XML Data for querying the data from the company
database. The dashboard will be dynamically loaded with the selected business partner type — Customer or
Vendor, also enabling the drilldown to open the selected Business Partner Master Data in SAP Business
One. After the dashboard generation with SAP Crystal Dashboard Design, we’ll package the dashboard with
SAP Business One Dashboard Packaging Wizard, and deploy it in the target SAP Business One system.

Top 10 Business Partners | customer [§l
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Procedure
1. Generate the User Query(s) in SAP Business One

Design dashboard(s) with SAP Crystal Dashboard Design
Export the dashboard to flash file

o b~ 0D

Design-Time Phrase

Package the Dashboard(s) with SAP Business One Dashboard Packaging Wizard
Deploy the Dashboard Package in the target SAP Business One system

Run-Time Phrase

Design Dashhoards Package Dashboards

Procedure:

1. Generate the User Query(s)
in SAP Business One

2, Desi%n and preview
dashboard with Xcelsius

3. Export the dashboard into
flash file

Procedure:

4. Package the Dashboards
with SAP Business One
Dashboard Packaging Wizard

Design-Time Phrase:
®  Should be done in development system
B Require the skill set of SAP Business One Query and Xcelsius

To create the sample dashboard, do the following steps.

Step 1 — Generate the User Query(s) in SAP Business One

Design-Time Phrase

Deploy Dashboards

Procedure:

5. Import and deploy the
dashboard package into the
target system.

Run-Time Phrase:

®  Should be done in the target
system

m  Authorize the User Query Group
and Cockpit for end-users

Run-Time Phrase

Design Dashboards Package Dashboards Deploy Dashboards

Procedure: + Procedure:
1. Generate the User Query(s) : 4,
in SAP Business One '

2. Designand preview ;
dash%oard with Xcelsius

3. Exportthe dashboard into
flash file

Packa
with SAP Business One ]
Dashboard Packaging Wizard |

[Design-Time Phrase:| ;o

m  Shouldbe done in development system -
] Require the skill set of SAP Business One Query and Xcelsius H

Generate the following User Query about Top 10 Business Partners with CardType as parameter order by

balance.

Procedure:
e the Dashboards 5.

Import and deploy the
dashboard package into the
target system.

Run-Time Phrase:

Should be done in the target
system

Authorize the User Query Group
and Cockpit for end-users

Query Category Dashboards_Demo

Query Name Top_10_BPs

Query

SELECT TOP 10 T0.[CardCode], TO.[Balance] FROM OCRD T0
WHERE T0.[CardType] = '[%0]' ORDER BY TO0.[Balance] DESC

Authorization
Group

Note: Set up Authorization Group of Query and Authorizations for end
user accordingly.
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E] Note

Query should be generated manually in the development system in the design phrase, and
will be generated automatically in the implementation system while importing the dashboard into
the target system.

QUE!YZ
T )

¥ |SELECT ToP 10 TO.[CardCode], TO.[Balance] FROM QCRD TO WHERE TO. ;I
[CardType] = '[%0]' CRDER BY TO.[Balance] DESC
=
# EP Code Account Balance
1 CEDOOD 8,949,39
2 42000 E4,925.00
= 20000 1,272.00
4 Crenr E00.00
E 299999 0,00
E 99998 .00
7 CFO0an .00
a2 L0000 0.00
) 10000 0.00
10 40000 0,00
[ Execute “ Cancel I I Reverse Table I l Save “ Cpen I |];|]]
Query Category:
‘savequery  _x
uery Mame
Top_10_EP=

Caery Category

Crashboards_Cemo Manage Cateqories

» Dashboards_Derno

Top_10_EPs

Top_10_Ttems

Gereral

SAP_DASHEOARD 001 _DABOOL_QUERY
SAP_DASHECARD_001_DABN0Z_CQUERY
SAP_DASHECASRD_001_DABN03_GUERY

[ Save I l Cancel J Rermowve

Authorization Group:
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© 2010 SAP AG 9



Creating New Dashboard Packages for SAP Business One 8.8

SEdit Categories

Categary Mame | Dashboards_Derno

Swshemn

General

SAP_DASHECARD 001 DABNNL_CLUERY
SAP_DASHEOARD _001_DABNNZ_CLERY
SAP_DASHECARD _001_DABNNZ_QUERY
Dashboards_Demo

Authaorization Groups

Group 1 GEroup B - Group 11
aroup 2 Group F Group 12
Group 3 Group § Group 13
aroup 4 Group 3 Group 14
aroup & Group 10 - Group 15
[ Update I l Cancel J Clear all
Authorizations:
Authorizations x
Bl Find
Elil
Subject Authorization
Eli2
- P Human Resources Full Autharization v .
bill w Reports Full Authorization -
bob b Sales and Purchasing Full Autharization *
brad ¥ Juery Generator Full Authorization -
Sl Mew Queries Full Authorization bl
doris Create/Edit Categories Full Authorization hd
Saved Queries - Group Mo, 1 Full Autharization ¥
] Saved Queries - Group Mo, 2 Full Authorization hd
james Saved Queries - Group Mo, 3 Full Authorization -
jirn Saved Queries - Group Mo, 4 Full Authorization e
john Saved Queries - Group Mo, 5 Full Authorization bl
inda Saved Queries - Group Mo, & Full Authorization hd
Saved Queries - Group Ma, 7 Full Authorization bl | 4
manager
Max, Discount - Sales 100.000 Expand ] l Collapse I
ax, Discount - Purchase 100,000
Max, Discount - General 100,000
[] Max. Cash Armacunt for Incorming Payrments
I Full Autharization I l Read Only ] l Mo Authorization J
(e
Step 2 - Design SAP Crystal Dashboard Design dashboard
Design-Time Phrase o Run-Time Phrase

Package Dashboards Deploy Dashboards
Procedure: Procedure: : Procedure:
¢ 1. Generate the User Query(s) i 4. Packagethe Dashboards ! 5. Import and deploy the
H in SAP Business One H with SAP Business One : dashboard package into the
i |2. Designand preview ; Dashboard Packaging Wizard | target system.
: | dash%oard with Xcelsius | !

3. Exportthe dashboardinto
flash file

Run-Time Phrase:

| Design-Time Phrase: | ] Shatuld be done in the target
system

m  Should be done in development system ! = Authorize the User Query Grou
®  Require the skill set of SAP Business One Query and Xcelsius i and Cockpit for end_,_,sgs P

You can refer to the “Top_10_BPs.xIf” sample file provided as a dashboard sample together with that article.
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1. Load the “SAP Crystal Dashboard Design” (tip: make sure that excel is not running at the
background).

2. Prepare the data area according for your needs. For example, the data of BP Code and Balance are
just sample data for design-time reference; they will be dynamically loaded as query result in run-
time. The data of BP Type fields will be used for selecting the business partner type:

A B C D E
1 Title Top 10 Business Partners
2 BP Code Balance BP Type
3 |C010 1000 Customer ©C
4 |C009 900 Wendor 5
5 |C008 800
6 |CO07 700
7 |C006 600
g |C005 500
9 |C004 400
10 |C003 300 |
11 (Cooz2 200
12 |Coon 100
13
4 4 » ”IL Top_10 EPs_Data I’_Queries "

D Note

You can refer to SAP Crystal Dashboard Design Help and training material to learn more about
SAP Crystal Dashboard Design.

3. Add a chart to your SAP Crystal Dashboard Design canvas area, for example: Column Chart. Fill the
chart’s properties as described below:

a. General > Titles = Chart: Select the Title value (In this example, it should be
Top_10_BPs_Data!$B$1)
A B

1 Title | Top 10 Business Partners |

b. General - Titles > Category (X) Axis: Select the BP Code cell (In this example it should be:
Top_10 BPs Data!$A$2)
A B

1 Title Top 10 Business Partners

2 |BP Code | Balance

c. General - Titles > Value (Y) Axis: Select the Sales the Balance cell (In this example it
should be: Top_10_BPs_Data!$B$2)
A B

1 Title Top 10 Business Partners
2 BP Code

As aresult, the Titles of Chart should be:

Colurnn Chark 1 o x
I & i (-
iy - lis” W ) ,
— \} Aty - (@
General Drill Down Behaviar Appearance Alerts

Titles

Chart:

Top_10_BPs_Datal$Bf1 i3]
Subtitle:
.3]
Category (X} Axis:
Top_10_BPs_Datalbasz [E.3]
walue () axis:
Top_10_BPs_Datal$Bsz i3]
Secondary Yalue (¥) Axis:
SAP COMMUNITY NETWORK SDN - sdn.sap.com | BPX - bpx.sap.com | BOC - boc.sap.com
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d. General > Data > By Series

Name: Select the Sales the Balance cell (In this example it should be:

Top_10_BPs_Data!$B$2)

Values(Y): Select the Balance values list (In this example it should be:

Top_10_BPs_Data!$B$3:$B$12)

Category Labels(X): Select the BP Code values list (In this example it should be:

Top_10_BPs_Data!$A$3:$A$12)

Daka

O By Range
|T0p_1lJ_BPs_Data!$B$3:$B$12 =
Crata in Rows Data in Columns
@ By Series
Marme:
|Top_10_BPs_pataigesz | Pl
values(y):
llr=e 1o Ers_Datalsagasa512 | | 3]
Plok Series On:
@ Primary Axis
()} Secondary Axis
= ~ v
Cakegory Labels{x):
|Top_to_EPs_Data'¢agsisagiz | | 3]

n Recommendation

You are recommended to set Fit Canvas to Components. Hence the chart is filled over the

whole canvas.

op_10_Customers.xIf - Xcelsius 2008

: File 3SAaP Edit Yiew Format Data  Help

PN S % s oo [+ 6 e e [ | O quidviens - | MElerevew } G| &) 57 B 3

i ] Themes ~ il Colors = i [B{ I | |2 & S| T < Wl ogs

Components a x

Category | Tree | Lisk |

Favorites

Charts

Line Chart

@

Containers

Selectars

Single Yalue
Maps
Text

Other

— 1l L] Tk By Ch O ¢ @ Quick Start

Top 10 Business Partners

Customer

CO10 CO09 CO08 CO07 CO0& CO0S CO04 CO03 Con2 cooil
BF Code

4. Prepare another sheet about the query information, which will be used to define the connection
parameters for XML Data in SAP Crystal Dashboard Design.

A B C o] E F G

1 Query_Category |Query_Name |Param_0 |Param_1 |Param_2 |More...
2 Top_10_BPs Dashboards_Demo|Top_10_BPs = | |

3

a4
. —
7

8

9

10

11

12

13

4 4 » »| Top_ 10 EBPs Datal Queries JEE > |-
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Send_Name

The variable name sent to Blic with Xml Data query

Query_Category Query Category: Dashboards _Demo

Query_Name

Query: Top_10_BPs

Param_x

X stand for the sequence of parameter in the query. e.g:
Param_0: stand for [%0], We have define

CardType as parameter '[%0]’, so we set the default value as C —
Customer.

Param_1: stand for [%1]

You can add as many parameter as necessary, just keep the right
sequence.

g Note

The names of Send_Name, Query_Category etc are just for information, it can be other words.
But it is critical to keep the sequence.

5. Add an XML Data connection from menu Data - Connections:

Fill the Definition properties:

Name The connection name. e.g. “Top 10 BPs”

XML Data http://<Server>:8080/B1liXcellerator/exec/ipo/vP.001sap0004.in_HCSX/com.sa

URL p.bli.vplatform.runtime/INB_HT_CALL_SYNC_XPT/INB_HT _CALL_SYNC_X
PT.ipo/proc?bpm.pltype=xml&bpm.encoding=utf-8
g Note
You should replace the <Server> with your server name.
During the design-time phrase, in order to preview the dashboard in SAP
Crystal Dashboard Design we’ll set the full URL. But in the run-time phrase it
only requires the relevant path (proc?bpm.pltype=xmi&bpm.encoding=utf-8),
since SAP Business One will compose the full path.

MIME Type Choose “text/xml”

Enable Send | - Select Enable Send
- Add a Send Variable
- Select the Sent Variable Name as the value of Send_Name. (In this example,
it should be: Queries!$A$2)
- Select the Range as the list from Query_Category to Param_X. (In this
example, we have only one parameter in the query, thus it should be
Query_Category to Param_0: Queries!$B$2:$D$2)
Click the Preview XML, it should show:

SAP COMMUNITY NETWORK
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- =data=
- «wariable name="Top_10_BPs">
— <rOw s
<columnz=Dashboards_Demo</columnz
<column=Top_10_BPs</column=
<columne=C</oolumns
<o
</ variable=
</dataz

Enable Load | - Select Enable Load

- Add a Load Variable

- Select the Load Variable Name as the value of Send_Name. (In this
example, it should be: Queries!$A$2)

- Select the Range as the lists of BP Code and Balance in the Data sheet. The
data will be dynamically loaded in run-time.

In this example, it should be: Top_10 BPs_Data!$A$3:$B$12)

A B c
1 Title Top 10 Business Partners
2 BP Code Balance
3 JC010 1000
4 |co09 200
5 |Coo0s 800
6 |Coov 700
7 JC006 600
8 |C005 500
9 jcoo4 400
10 JC003 300
11 JCoo2 200
12 |C001 100
13
M 4+ [ Top 10 BPs Dats JQueries 7]

Click the Preview XML, it should show:
- =datax
— «<wariable name="Top_10_BPs">
— FOW
zcolumn=C010=/colummn:=
zcolumnz=1000</columns
<o =
— FOW
Zcolumn=C009=/column=
column=900</column=
B R
+ O
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A vacuilt thAa AAafinitinn Af +thAa VAL

NAata chAnld hae

aData Manager

X

=3

;.% Query as a Web Service Eriniton " 2 ‘

_:3] ‘Weh Service Cannection Name: Top 10 BPs

:-31 SAP MetWeaver BW Connection

T XML Data URL: IfNC_XPT,I'INE_HT_CALL_SYNC_XPT.ipo,lproc?bpm.pltype=xml&bpm.encoding=utf-8 | E
2 AL Data

13 Flash Yariables MIME Type: | textfxml 'vl

[ Portal Data

|\ Crystal Reports Data Consumer nable Send Enable Load |-

3 F5 Command Tame: Tame:

:_% LCDS Connections Queries a2 E Queties!$a42 E
:_% External Intetface Connection Range: R.ange:

- = 5 oo b toio

visting Connections | QuerizsifEtedoiz. || Tap_10_EPs_Datalbeds|| )
b Execel ¥ML Maps

'.ﬁ [- ] Preview ML

|r} Live Office Connections

I Preview “ML | | Import Mamed Ranges |

Closs |

In the Usage tab, by default, the refresh option is selected as Refresh Before Component are Loaded.
6. Preview the dashboard in SAP Crystal Dashboard Design by clicking the Preview Button in the tool

bar.

NG H] % Gan] e[+ 8T E s 5] ke - PEreer ] 5 &5 T @

Themes - :Colors - m IE:l = & S| I

all

soe & 5 1] L] T B Gh G i @ Quickstart

The following window displays for authentication.
Connect to localhost

The server localhost at
B1liP_ipo_jwP.001sap0004.in_HCSX fcom.sap.b li.vplatform.ru
ntime/INB_HT_CALL_SYNC_XPT/INE_HT_CALL_SYNC_XPT.ipo
Jproc requires a username and password.

Warning: This server is requesiing that your username and
passwor sent in an insecure manner i ntication
without a secure connection).

User name: IE LI
Password: I
™ Remember my password
oK I Cancel I

User Name:
language/user_name/company_name
language\user_name\company_name

e.g. en-US/manager/SBODemoUS

(language enumeration:

cs-CZ, da-DK, de-DE, el-GR, en-CY, en-GB, en-
US, en-SG, es-AR, es-CO, es-ES, es-PA, fi-Fl,
fr-FR, he-IL, hu-HU, it-IT, ja-JP, ko-KR, nlI-NL,
no-NO, pl-PL, pt-BR, pt-PT, ru-RU, sk-SK, sr-
YU, sv-SE, xx-XX, zh-CN, zh-TW)

Password:
The B1 user password (the one for manager for
example)

Hebrew characters are not allowed in password.

After the authentication, now you should be able to see the Top 10 Business Partners dashboard

from your company live data:

SAP COMMUNITY NETWORK
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Top 10 Business Partners

100000
20000 Balance
C<42000
4 BO000
2 64925
fan)
= 40000
ui]
20000
0 [ [ o = (=] o = [ = [
o o [ [ai) () [y} o o o o
o o o ] o ()] o o o =
o o [ (] [y ) o o o
w =+ ol [my) [y} - L — =+
O [ O [ [ [ O o [
BF Code

Trouble Shootings:
a) Cannot Access External Data with Error #2032

R e E—

Check List:

- Make sure SAP Business One Integration Service is running in windows service.

- Make sure SAP Crystal Dashboard Design 2008 Fix Pack 3.1 or higher and Adobe Flash
Player 9.0 or higher installed

- Make sure MIME Type is selected as text/xml in XML Data Definition

b) No data displays. Mostly run-time error during query, no data retrieved.

Top 10 Business Partners

T T T 1 u ]

Balance

=

BF Code

Check List:
- Make sure the query can be executed successfully in SAP Business One
- Make sure the right query category ,query name and parameters given.

D Note

You can use some Http debug tools such as Fiddler etc, checking out the Http request and
response.

SAP COMMUNITY NETWORK SDN - sdn.sap.com | BPX - bpx.sap.com | BOC - boc.sap.com
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7. (Optional) Add FS command to enable B1 link function for Business Partner Master Data.
This selected BP code will be used in FS Command to trigger to open the selected Business Partner

in SAP Business One.

a) Enable Drill Down for the column chart.

Drill Down - Enable Drill Down: When the end user is selecting a Business Partner by mouse
clicking in the column chart; the selected BP code will be filled to the target cell marked in yellow.
The source data is BP Code and Balance, the destination for selected BP code is the yellow cell.

Columnn Chart_1 2 x
| (®
[ = il | /|7 - v
TIE —=J = L -
General Drill Doven Behavior Appearance Alerts

Enable Drill Down|

Series Mame Destination:

Tip: Click to this icon for quick demo explanation _J

Top_10_BPs_Data $046 =
Insertion Type:
[Fon e
Series Source Data: | A
: T w1 Tite
Destination: 2 BP Code Balance
1 E et - 3 |C010
II — = C009
5
6 |Co07
Interaction Options g SSSE
Insert On: | Mouse click ~| 9 |Coo04
Default Selection 10 |C003
11C002
Series: " 12 |C001

13

Item: I Mo Selection (-1} b |

—

H 4 » M| Top_l0_BPs Data . Queries ,

Top 10 Business Partners

1000

900
800

600
500
400
300
200
100

D E;

BP Type
Customer

C
Vendor IS _l

Selected BP Code
NULL

j=]

b) Add a FS Command with Data Manager. The FS command will be triggered to open the selected
Business Partner Master Data in SAP Business when selecting BP in column chart. You should
choose FS command in Dashboard Packaging Wizard. It will generate the script for the FS

Command handler in HTML. See in the dashboard packaging later.
[dliootoManager

e |
Add -~
5 Query a5 & Web Service Definition | I Lisags
2 Web Service Connection Name: |BPClick
3 SAP NetWeaver BW Connection .
5, XML Dats Command: BPCHck =]
iy Flash Variables Parameters: |Top_l0_BPs_Datal$D$7 ]
& Portal Data [ Encode Pararfeters
5. Crystal Reports Dats Consumer
|2 FS command |
T3 LCDS Connections
5 Externsl Interface Connection
B Excel XML Maps
£} Live Office Connections Close
i A B C D E H 1
1 Title Top 10 Business Partners
Z BP Code Balance BP Type
3 Cco10 1000 Customer <
4 Co009 900 Vendor s
5 Coos 800
& C007 700 Selected BP Code
7 |Co06 600 MULL
8 CO005 500
9 Coo04 400
x|
) Top 10 EBP:
S RMLData Definklon
»  BPClick
= FS . rovider Options
Communicate on Trigger
= (&) when value Changes "
() when value Becomes =
+ + x
Clase
= - o

8. (Optional) Add a Comobox selector for selecting BP type interactively. Therefore, Top 10 Business

Partners is showed dynamically by Vendor or Customer.
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Companents 1 x

Combo Bax 1 2 x
tegory]| Tree | Lt | Top 10 Busi Part = L) b
[o] usingss Fartn = Customer e
Favoritas = P . . x e { J
Chats 1200 General | Behavior  Appearance  Alerts
— /|
Containers 10 e THe
@ 800 ‘
8
= o 5 oo
= Labels
Combo Box Filter 400 || R e wiser o]
200
Data Insertion
[ ooooy =
€010 €003 CO08 COD7 CO0G CO05 CO04 CO03 CO02 CO0L i -
Fisheye Picture  Sliding Picture
Menu Menu BF Code BF Type
Single Value
Inserkion Typs:
Maps d9-c- )¢ |
V=] | Hom:\ Insert  Pagelayout Formulas Data  Review  View ins @
Other ? * Souree Data;
Arial tlo - % = A0
it and Backgiounds 7j Er) ‘B I u 'HA‘ = A & A - TDD_ID_EPS_Data\$E$3:$E$4]
b Connectivy il T Alignment Number  Shles | Cells 4 S —
G — Clipboard Font ] Editing |
=5 4 -0 fs
Rl colun Chart 1 s A 8 c
= ComboBon 1 o 1 Title Top 10 Business Partners
= 2 BP Code Balance
3 |co10 1000
4 C009 900 [ clear Destination When No Selected Ttem
5 Co08 800 -
6 C007 700 Selected BP Code et on:
7 C006 600 NULL (%) Data Change and Interaction
8 Co0s 500 o
9 cood 200 Interaction Gnly
10 C003 300 v
+ + X |t | Top_10_Bps Data ,<Queries 7¥2 4 [N I < [0 >
Destination: Param_0 — BP Type
A B C D E F G
1 Query_Category |Query_Name Param 0 |Param_1 |Param_2 |More...
2 [Top_10_BPs Dashboards_Demo|[Top_10_BPs C | |
3
Behavior:
Combo Box 1 nox
_I ! y \
— > .
T = ) =
General Behavior | Appearance Alerts
Comrnon —" Animations and Effects |
Selected Itsm
Type: Label =]
Ttem: | Label 1 ~| ™
Insert Selected Item:
Ignore Blank Cells
Ignore cells at End-of-Range only,
Dynamic Visibility
Show component only if status matches key:
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Step 3 — Export the SAP Crystal Dashboard Design dashboard into a flash

Design-Time Phrase » Run-Time Phrase i
Design Dashboards Package Dashboards Deploy Dashboards
! Procedure: ! Procedure: i Procedure:
i 1. Generate the User Query(s) i 4. Packagethe Dashboards ;5. Import and deploy the
H in SAP Business One ' with SAP Business One H dashboard package into the
i 2. Designand preview | Dashboard Packaging Wizard | target system.
: dashboard with Xeelsius H :
i |3. Exportthe dashboard into H
i flash file : '
' ' i Run-Time Phrase:
[Design-Time Phrase: |  m  Shouldbe donein the target
- Should be done in development system ! m :}:;s;eon:ize the User Query Grou
] Require the skill set of SAP Business One Query and Xcelsius H 4 P

: and Cockpit for end-users

1. Before export, we need to switch XML Data URL as the relevant path
(proc?bpm.pltype=xml&bpm.encoding=utf-8)

aData Manager 5'
Add |
by Top 10BPs —
L% WML Date Definition | Usage
MName: Top 10EBPs
ML Data URL:||Ernc?hpm.pltype:xml&hpm.encnding:utf-ﬁ L ]
MIME Type: ket fml “
Enable Send Enable Load
Mame: Mame:
Queties!$ade E‘ Queties!$ade E‘
Range: Range:
Clueries|$EE2: 402 M~ Tap_10_BPs_Datsia43:4E| [
EI Preview XML
E] Preview XML | | Import Named Ranges I
+ + x
Close |

2. In the upper menu click on File > Save

3. Inthe upper menu click on File > Export > Flash (SWF). Save it as Top_10_BPs.swf in your

computer.
Export Jd JES|

Save i IE) Howe-to LI & L

File name: ITODJ 0_BPs.swf LI Save I
Save as type | £dobe Flash .swi) =1 Cancel |
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Step 4 — Package the Dashboard(s) with SAP Business One Dashboard Packaging Wizard (B1DW)

Design-Time Phrase i Run-Time Phrase

Design Dashboards Package Dashboards Deploy Dashboards

Procedure: i Procedure: i Procedure:
i 1. Generate the User Query(s) i [4. Packagethe Dashboards ;5. Import and deploy the
' in SAP Business One ' with SAP Business One 1 dashboard package into the
! 2. Designand preview H Dashboard Packaging Wizard | | target system.
: dashboard with Xcelsius H :
i 3. Exportthe dashboardinto i :
i flash file : '
' ' i Run-Time Phrase:
| Design-Time Phrase: | Pom Should be done in the target
= Should be donein development system Pm :T‘ieon:ize the User Query Grou
- Require the skill set of SAP Business One Query and Xcelsius ; and Cockpit for end-us;}rfs P
1. You can download this Add-On tool and documentation from
http://www.sdn.sap.com/irj/sdn/businessone -> SAP Business One Tools -> IMPLEMENTATION
TOOLS
2. Register and install the Add-On.
3. Atfter starting the Add-On, you can launch the wizard from the following menu.
File Edit Wiew Data Goto Modules Window Help
Rl & |J =] = s Prink Layout Designer. ..
#L Reporter
Presview External Crystal Reports File
'a My Cockpit : Form Settings. .. Chrl+Shift+5
Change Log...
Home {Current) Queries »
Py Mena »
My Shorbcuts »>
A User-Defined Yalues Shift+Fz
% EiRerED User-Defined Windows 3
= Cockpit 3
. Customization Tools »
i Defaulk Forms »
= Screen Painter
‘% | Dashboard Package Creation |
4. Follow the Dashboard Package Creation Wizard
Dashboard Package Creation ='B'x
Dashboard Package Creation Wizard
The Dashboard Package Creation Wizard enables you to create the necessary file
ta inlcude ywour Dashboards in SAP Business One,
The wizard will guide you step-by-step through the definition of parameters
required ba gerer ate thiz package,
Cancel Mext =
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Dashboard Package Creation

Dashboard Package Creation Wizard

Fill the general information for creating the package, The partner Mamespace will be included in the package
unique code and will be part of the package name after creation,

Package general information

Partrer Mamespace: M
rigque Code: A Top_10_EPs
Mamne: Top 10 Business Partners
Drescription: Dema Cashboard Package - Top ;I
10 EP=
=
Author: Yatzea Li
Wersion: 1.0

Cancel ] [ = Back ] [ MHext =

E Note

You should replace XXX with you Partner Namespace.

Dazhboard Package Creation Wizard

Inchude the name of the Dashboards that will be inside the package,

Dazhboard information

Unigue Code Marne Drescription S Fila Path itidth Height
DasS0001 Top_10_BPs  Top 10 BPs 100% 10036 -
[ Cancel ] [ = Back ] [ Haxt = ]
Select the flash file exported in Step 4.
open 2l x|

cf E-

Lookir: [ 155 Howeta =l «

& =]

File name: ITop_1 0_BPsz.zwf ;I Open I
Files of type [ s files [ swif] =1 Cancel |
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Dashboard Package Creation —'Aax

Dashboard Package Creation Wizard

Select the queries that will be part of each dashboard. To select the queries, select the desired dashboard from the
combobox, and then click the Checkbox to select it.

Dashboard information

Dashboard Code: DASO00L J

4

Categary Queryame Selacted  Query

w [ashboards_Cemo | -
|Top_10_EPs SELECT TOP 10 T0[CardCade], To.[Bal|-
Top_10_Ttems 1 SELECT TCP 10 TO[TtemCode], 0[O0

- SAP_DASHECARD_001_CMENTL_QUERT O
BacklogBEyDate ] SELECT TOP 10 count distinet s0.CallID]
DusbyTaday (| SELECT Count(CallID) FROM OSCL Wik
Cruetextiniaek I:‘ SELECT COUNT(CallID) FROM SSCL W

4 3

l Cancel I l = Back J l Mext = I
Select query for the dashboard.
Dashboard Package Creation = =

Dashboard Package Creation Wizard

[Optional) You can use FSCommand in SAP Dashboard Design (¥celsius) to enable end user to open
SAP Buinesz One master data or document form by clicking cormponents in dazhboard. Just like clicking link button
in SAP Business One,

FSCarnmand Infarrnation

Dashboard Code: DAsSn001 -
FSCommand Object
[Erciick GCRD | -

¥

(Optional) The FS Command "BPClick’ defined in step
7 of designing the dashboard. Object OCRD stands
for Business Partner in SAP Business One. You may
let it blank if FS command is not defined.

l Cancel ] l = Back ]I[ Create ]I
Select the folder to save the dashboard package.
2]
B 1) 11-B1 |
SREE=A]
S cr
1) iPhone
=) PLIZ J
[ I25) DashBoard
=
IC3) SAP Dashboard Package 2
IC3) Top 10 Customers
B Top 10 Items
I Trouble Shootings
2.0 -
o | i
Make Mew Folder | O I Cancel |
A
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Dashboard Package Creation

Dazhboard Package Creation Wizard

The package was created succesfully in the Following path:

D0 1-Solution Architect’ 11-B1%&.8VPL1ZYD ashEBoardyHowe-to 33 _Top_10_EPs.zip
and is ready to be imported in SAP Business One Cockpit,

[ = Back ] [ Einish ]

The structure of Dashboard Package:

Fil=  Commands Tools

Fawvarites  Oplions

Extract To Test

Wiew

J m |J I@ ¥y _Top_10_BPs.zip - ZIP archiv

Mame  4& | Size |
=
[CiDAs0001

inFa. il

Inside DAS0001:
Marme 45

665

Size

& default,html

Q27
Top_10_EPs,swf

565,533
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Step 5 —Deploy the Dashboard Package in the target SAP Business One system

) Design-Time Phrase Run-Time Phrase

Design Dashboards Package Dashboards > Deploy Dashboards

! Procedure:
o Generate the User Query(s)

Procedure:

4. Packagethe Dashboards i

with SAP Business One H
2. Designand preview H Dashboard Packaging Wizard |
dashboard with Xcelsius H i

Procedure:

5. Import and deploy the
dashboard package into the
target system.

in SAP Business One

3. Exportthe dashboardinto
flash file

Run-Time Phrase:
Design-Time Phrase: m  Should be donein the target
[ ] Should be done in development system system

[ ] Require the skill set of SAP Business One Query and Xcelsius H M :#g‘g;igzgn?o‘;'seﬂd?::gssmm

1. You can import the dashboard package in SAP Business One through menu:
Administration => Setup => General =>Dashboard Manager

‘Welcome, manager. You are in the Home cockpit of Headquarter - OEC Computers,

Dashboard Manager

B! Administration

w SAP Dashboard Package 1 -
. i) Top_10_Customers

Service Cal
Custamer Aging Mame [rashboard Package for Top 10¢
Sales Analysis Authar E1SA

F Dashboard Package for Top 10 Custorne Version 10

W SA Dashboard
First Dashboard [rate Imported 07 f02f2010 17108

Drescription

]

Dashboard Package For Top 10 Custorners by B1SA

| Drag & Relate
0 E

E E
=

Predefined T

]

Freight

]

Report and Layout: Manager

Export H Dalste

]
4

ials
ort button to launch the Dashboard Import Wizard

Click the Imp

Dashboard Import Wizard

Dashboard Import Wizard

Uze thiz wizard ta irmport dazshboards and related queries,

To start, choose the "Mext” button,

[ Cancel ] | Back | [ Mext ] [ Executs
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Dashboard Import Wizard

Select dashboard package to import
Crashboard Package O W0 1-Salution Architect\ll-Bl\S.8'\.PL12\DashBoard\How-to\){}{}{_T
o) ¥xH_Top_10_EPs
Marne Top 10 Business Partrers
Authar ‘fatzea Li
Werszion 1.0
Crazcription Cemno Dashboard Package - Top 10 BPs
Drashboard List hin] Fame
DAS0001 Top_10_BPs a
-
Step 1 of 3 [ Cancel ] [ Eack ] L Mext Execute I
Select the dashboard package in Step 4.
open 21x]
Loalk in: IE} Haowe-to ;I @ _? > '
| ) 4695220 3-ef de-4ff9-b237-c036c 7 ebfSF7
op_10_F

File name: |>¢0<_T0p_1 0_BPs.zip ;I Open I
Files of type: IDashboard Package [*.zip] ;I Cancel |

e

Dashboard Import Wiza —

Select queries to import.

Impart queries in this package,
[IF queries are not imported, the dashboards in this package may not function correctly,)

Caery Category Query Marme Stabuz
Crashboards_Dema Top_10_EPs Crarwrite -

Dashboard Import Wizard

Some of the queries will be overwritter. (2 ,

Are you sure wou want bo owerwrite these queries?

h Yes Mo
Step 2 of 3 [ Cancel ] [ Eack. ] I Mext I L Execute ]
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Dashboard Import Wizard

Import completed successfully.

The Following dashboardsfqueries have been created:

Crashboard = Top 10 Business Partners = Top_10_BPs
Cuery = Dashboards_Demo = Top_10_BPs

Step 3 of 3

I Eack I l lext J [_ Close ]

Dashboard Manager

B SoP Dashboard Package 1 -
P Cashboard Package For Top 10 Custorne

w|Top 10 Business Partmers [RET T
Top_l0_BPs Status

[Crescription

Top 10 EPs

jie)

DASOONL
Top_10_EPs

I.l'—\.cti\re v‘

Crefine User Autharizations ]

L oK ] [ Cancel ]

Now, the end-user is ready to add and view the dashboard in run-time.

tﬂ My Cockpit

“Welcome, manager, You are in the AfR cockpit of Headguarter - OEC Computers,

Dashboards &
(@

Drag & Relate

To add a dashboard, click the taol icon and choos
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Select Dashboard x @ Top_10_BPs £
Select dashboards For this widget . . j
#  Dashboard Bisplay 60000 Top 10 Business Partners  customer [

1 Custamer Aging [}
2 Sales Analysis ] 100000 Befbrass
3 Service Call O Cen0oo0
4 Top 10 Custormers O 0000 F8945,99
s | Top_10_BPs | P
&
e
o 40000
o
[ui]
20000
0 =
[=] =] o - o o [=] =] =] o
=} =1 a @ =] = =} =1 =1 =
o2 @ o & 9 @ 2 o g o
(=) o o o o o o + o
=) o+ ] uy - o+ (0] Iy o
o v oo U U o0 v ou oo
BP Code
T )| [ cameet | [ Sat 2z Diefault | ﬂ

CIickini the column of one BP will o: en the selected Business Partner Master Data.

Code Ceo000 Customner ¥ EP Currency i

Marne 5G Electronics Account Balance > 104, 165,10/ [l
Foreign Mame Deliwaries o.00
Group Production - Orders > 1.763.46 (b

Currency Canadian Dollar > Oppertunities
Faderal Tax ID.

Geperal | Contact Persons | Addresses | Paymert Terms | Payment System | Accounting | Properties | Remarks |

Tel 1 (333) 980-7791 Conktact Person Eric Alexander
Tel 2 10 Mo. 2

Mobile Phone

Fax (333) 980-7723

E-Mail infe@sg.com.ca Femarks

ek Site . 3g.com.ca

Shipping Type UPS Ground (=) Salez Employee Jim Boswick kd
Pastword

Factoring Indicator

Project - BR Channel Code
Industry - Technician
Business Partner Type Company > Territory

Alias Mame

@ Active B To Remarks

[ —
) Adwanced

ok ][ cancel [ Related Service Calls || Activite || Belated Activities
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Related Content
For more information about this topic:

1) SAP Business One Dashboard Packaging Tool — http://www.sdn.sap.com/irj/sdn/businessone ->
SAP Business One Tools -> IMPLEMENTATION TOOLS

2) SAP Crystal Dashboard Design Landing Page -
https://service.sap.com/~form/sapnet? SCENARIO=01100035870000000183& SHORTKEY=01100
035870000711038& OBJECT=011000358700000566202008E& ADDINC=0110003587000011926
82007E&

3) Download the Sample
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